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Introduction

The "Morpho User Guide" is provided to assist with the use of the Morpho 
application. Morpho can be used to create ecological metadata, and store and query 
ecological metadata housed on one's local system, or from the distributed Metacat 
servers.
 
Knowledge Network for Biocomplexity (KNB)

The KNB is a national network intended to facilitate ecological and environmental research 
on biocomplexity. It enables the efficient discovery, access, interpretation, integration, and 
analysis of complex ecological data from a highly distributed set of field stations, 
laboratories, research sites, and individual researchers.
Three main components of the KNB are a data management tool, Morpho; a framework for 
storing and serving data and metadata, Metacat; and a formal specification for ecological 
metadata, EML (Ecological Metadata Language). Source code for all the products 
developed under the KNB are available for downloading at "http://knb.ecoinformatics.org/
software/"

 
Morpho

Morpho is a data management tool for ecologists. It was created to provide an easy-to-use, 
cross-platform application for accessing and manipulating metadata (e.g. documentation) 
and data (both locally and on the network). Morpho allows ecologists to create metadata, (i.
e. describe their data in a standardized format), and create a catalog of data & metadata 
upon which to query, edit and view data collections. In addition, Morpho provides the means 
to access network servers, in order to query, view and retrieve relevant, public ecological 
data!
The basic operations that can be carried out using Morpho are: 

●     Create and Edit Metadata 
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●     Search and Query Metadata Collections 
●     View Data and Data Collections 
●     Verify and Edit Data 
●     Provide Access Control 

Many types of "data" can be used with Morpho, including data tables and images.

 
Metacat

Metacat stands for "Metadata Catalog". Metacat servers allow ecologists to share their data 
and metadata via the Internet. A Metacat is essentially a server from which ecologists, 
through using Morpho-- can upload, download, store, query and view relevant metadata and 
data on the KNB (Knowledge Network for Biocomplexity). Metacat servers can also be 
accessed independently of Morpho, such as via a Web browser, or calls from a database, 
but this requires some specialized programming. Morpho is the easiest way for most 
ecologists to immediately access and store metadata and data on a Metacat. Among other 
things, the KNB supports a network of Metacat servers. 

 
Ecological Metadata Language (EML)

Ecological Metadata Language (EML) is a metadata specification developed by and for the 
ecology discipline. It is based on prior work done by the Ecological Society of America and 
associated efforts (Michener et al., 1997, Ecological Applications). EML is implemented as a 
series of XML schema and document types, that can be used in a modular and extensible 
manner to document ecological data. Each EML module is designed to describe one logical 
part of the total metadata that should be included with any ecological data set.
 
Read more about EML in the EML Handbook
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Getting Started
 
Download Morpho

The first thing you should do is install the Morpho software. Go to "http://knb.ecoinformatics.
org/morphoportal.jsp" and choose the appropriate link. You will have the option of 
downloading Java along with Morpho if you do not already have it. Follow the directions in the 
installer.
N.B. We recommend that you download the full version of Morpho with Java, since there are 
some minor incompatibilities with Morpho if you do not have the correct version of Java 1.4.2 
or higher. Morpho's installation of Java will only be used by Morpho, and will not disrupt any 
earlier versions of Java which you have already installed. 
Morpho 1.5 is a Java application that runs on Mac OSX and Windows 2000, XP, and higher. 
It also runs on Linux, but as of this version there are some minor display problems. We 
recommend installing Morpho on a newer, more powerful system, ideally a fast G4 Mac or 
Pentium 4 PC or higher, with 256MB of RAM or more. Morpho 1.5 is compatible with 
Ecological Metadata Language 2.0.0. 
 
Register for the KNB Network
After installing Morpho (but before using Morpho), register yourself on the KNB web site. Go 
to "http://ldap.ecoinformatics.org/cgi-bin/ldapweb.cgi" and fill out the form pictured below. 
Write down your name and password somewhere secure. Registering with the KNB Network 
will provide you with access to some advanced metadata and data services from the KNB, 
and does not install any networked spyware on your system, nor does it require that you be 
on a network in order to use Morpho.
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Open Morpho and Create a Morpho Profile
Open Morpho by double-clicking on its icon, or the file called "Morpho.bat".
 
The first time you execute Morpho, you will be asked to create a new profile. This profile 
allows you to use Morpho locally on your personal computer and, once registered for the 
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KNB network (see preceding "Register for the KNB" section), will allow you to create, access, 
edit and search for data sets on the KNB network.

If you are upgrading Morpho from a previous version, you will still be prompted to create a 
new profile. If you want to continue using your old profile(s) (so that your locally-stored data 
continues to be visible), simply enter a "new profile" with the same name as the old one, and 
you will be prompted if you would like to use the existing profile. For example, if your old 
profile is named "jdoe", then enter "jdoe" as the name of the new profile, and when you finish 
the profile wizard, Morpho will ask if you want to keep your existing profile -- click "Yes". This 
will only work if you logged into your computer with the same account under which your old 
profile existed.
Enter your profile name, and your first and last names, under "Basic Information" in the New 
Profile screen, pictured below. Your profile name does not have to be the same as your 
Metacat (KNB) network username.
 

Click "Next" to move on to the "Metacat Account Information" screen, pictured below. Here 
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you should enter the Metacat username and the organization name which you registered on 
the "http://knb.ecoinformatics.org/index.jsp" site. If you are not on the Internet, or you do not 
want to register with the KNB, you can enter any username here and Morpho will still work. 
But if you do not reference a valid KNB account here, and associate it with this profile, you 
will only be able to store your metadata files locally, and not be able to login to the KNB to 
take advantage of the advanced storage, access, and querying capabilities provided by 
Metacats.
  

 
Click "Next" to move to the "Miscellaneous Information" screen, pictured below. The identifier 
prefix that you enter will become the prefix of your stored metadata file names. For example, 
jdoe.xml.
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Click "Finished" to move on to the "Metacat Login" screen, pictured below, where you should 
enter your Metacat password. Alternatively, you can login on the main welcome screen of 
Morpho, described in the next section.
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! By entering your password and clicking the "Login" button you will be able to create, edit, 
search, access and manage data that is stored both locally (on your computer) and on the 
KNB network. By selecting "Skip Login" you will be able to do all the previous operations 
locally, and may search for data sets on the KNB network. However, you will not be allowed 
to create or edit data sets on the KNB network unless you are logged in via a valid KNB 
account. 
 
The next screen you will see after logging in is The Main Welcome Screen. Read about it in 
the next section.

 

Help Index Introduction       The Main Welcome 
Screen
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The Main Welcome Screen
 
After you have opened Morpho and created a profile, you will see the "Welcome to Morpho!" screen. 
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Welcome Screen Panels
Notice that there are three panels on the left side of the screen - the "Current Profile" panel at the top, the "Network Status" panel in the middle, and the "Work 
with your data..." panel at the bottom. Each of these is described below.
 

●     Current Profile Panel

The top of the panel shows the current profile setting. You can use the drop-down list to change profiles, or you can click on the link to create a new profile.

●     Network Status Panel

The top of the panel shows your login status for the KNB. If your status is "NOT Logged In", you can type your password in the "Password" field and click the 
"Login" button to login to the KNB network. You will be logged in with the username associated with the current profile, shown in the "Current Profile" panel. Note 
that this KNB username is not necessarily the same as your profile name. Your KNB username is the name appearing after the "uid=" just below the title bar of 
the "Current Profile" panel.
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After you are logged in, you will see the following:

Clicking on the "Logout from network" link will log you out of the KNB network.

●     Work with your data... Panel

This panel contains click-able links which allow you to:

●     Create a new data package, 
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●     Open an existing data package, or 
●     Search for an existing data package (both locally and on the KNB network)

A description of what each of these links does is provided later in this guide (click on the links above to skip to one of these sections).

Menus
The menus at the top of each Morpho screen allow you to access all the operations that are available in Morpho. 

 
  
Items will sometimes appear grayed out, meaning these are not available for use with the current data package. For example, "copy" and "cut" will be disabled 
on the "Edit" menu if you do not currently have any item selected.
 
It is a good idea to take a moment and familiarize yourself with the contents of each of the menus.
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●     File menu

Under this menu, you'll find prompts (pictured below) for creating a new data package, opening an existing data package, logging in and out of the KNB network, 
creating a new user profile, saving a data package, deleting a data package, printing documentation, setting preferences, exiting Morpho, and other options. 
  

 

●     Edit menu

In this menu (pictured below), you can cut, copy or paste items, as well as reverse changes you have made to a data table or to a set of data tables.
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●     Search menu

Under this menu (pictured below), you have the options of searching for data packages, saving a search for future use, refining a search by changing search 
parameters, or refreshing the current search. 
  

 

●     Documentation menu

This menu, pictured below, allows you to add, delete, or change a variety of different types of documentation (metadata) for your data package. You may add or 
edit general documentation for the data package, or more specifically add or edit information on the research project and usage rights related to the data 
package, as well as the geographic, taxonomic, and temporal coverage of the data. 
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●     Data menu

This menu (below) is where you will find tools that allow you to import a data object (such as a table or an image), or create a data table. Also, you may edit and 
manipulate the data in a data table using commands found under this menu. Finally, you may also add or edit the documentation for your data columns under 
this menu. 
  

 

●     Window menu

Under this menu you can view different windows that are open in Morpho. 
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●     Help menu

This is where you can access the Morpho User Guide, which contains help on all Morpho features. There is also an "About" item where you can read general 
information about Morpho.

 

  
Toolbar

The toolbar contains shortcut buttons to the more commonly-used commands found in the menus. The purpose of each button is described below. If you ever 
forget what a button is for, simply place your mouse cursor over the button and a small pop-up reminder will display the purpose of the button. 

The "new data package" button starts a wizard that will guide you through the process of creating a new data package of your own.

The "open package" button allows you to open an existing data package (provided you have adequate access permissions).

The "search button" begins the data package search process. If logged in to the KNB, you will be able to search both locally and on the KNB network.

The next three buttons are enabled only when the frame contains the results of a search. They allow you to refresh the search, save the search 
for future use, or revise the search by changing the search parameters.

 
Status Bar
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The status bar at the bottom of the Morpho window contains information about the current status of various Morpho settings and parameters. For example, when 
search results are displayed, the number of "hits" is shown on the left end of the status bar. 
 

 
The three icons located at the right end of the status bar indicate the following:

Network 
Status

  Network connection available
  Network connection not available

Login Status
   Logged into network
   Not logged into network

Security
   Using secure (SSL) connection*
   Not using secure (SSL) connection

* Note that Morpho does not currently support SSL connections. 
 
Read an Introduction to Data Packages on the next screen to learn more about what data packages are, and what they look like.
 
 

Help Index Getting Started       Introduction to Data Packages
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Introduction to Data Packages

 
What is a Data Package?
Data packages are the logical units that Morpho creates to represent your data files and 
their descriptions (e.g. documentation, or metadata). Morpho provides an easy interface for 
you to access your data and its documentation via these data packages. 
 
There are two main components of Morpho that deal with data packages: 

●     Data Package Wizard, which guides you through steps to create a new data package, 
and 

●     Morpho Editor, which helps you manipulate, edit, and add documentation to existing 
data packages.

The Data Package Wizard and Morpho Editor are described later in this document. Below is 
an introduction to data packages, and what these look like.
 
Data Package Panels
Morpho uses the term "Data Package" to describe a set of documentation and /or the 
associated data. A "Data Package" consists of either metadata alone, or metadata along 
with the associated data.
 
After creating a new data package, or opening an existing data package, you will see the 
contents of the data package represented by a "Data Package" screen, shown below for a 
sample data package.
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This screen consists of several parts. The standard Morpho menu and toolbar are at the top 
of the screen. Below these are three panels: the package documentation panel, the data 
table panel, and the table documentation panel. Each of these panels are described below
 

●     Package Documentation Panel

The top panel contains a brief "citation-style" summary of the data package. It includes 
icons to the right that indicate whether the package is located on the local machine, on the 
network, or both. 
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The top panel can be expanded to reveal additional documentation, either by dragging the 
divider bar, or by clicking the "more" link. The additional documentation is shown below.
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The blue links in this documentation window link to files that contain the documentation, 
displayed in EML format, or data. Clicking on one of these links will cause the relevant part 
of the documentation to be displayed in the current panel. For example, clicking the 
"tao.9049.1" link in the above screen would cause the eml-physical documentation to be 
displayed. After navigating to different documentation pages, you can use the "back" button 
near the top right corner of the panel to navigate back to the initial view (this works in a 
similar way to a web-browser's "back" button).
 
The Package Documentation Panel may be collapsed to its original size in one of several 
ways:
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1.  by clicking the "less" link;
2.  by clicking the "hide" button, located to the right beneath the net and/or local icons;
3.  by using the mouse to drag the divider bar, which is at the bottom of the screen, up or;
4.  by clicking the small arrow icons located on the left side of the lower divider bar.

The documentation may be edited by clicking the "edit" button that is located beneath the 
"hide" button. This will take you to the Morpho Editor, described later in this User Guide.
 

●     Data Table Panel

The data table panel, displayed below for a sample data package, either shows the data in 
spreadsheet form, or for several formats of image entities, displays the image. The tabs 
along the bottom of the data table panel may be used to select and view different tables or 
image entities within the package.
 
Using the drag bar on the right side of the panel, you can collapse, expand, or change the 
size of the data table panel.

file:///C|/work/morpho/docs/user/data_packages_intro.htm (5 of 10)4/18/2004 7:59:24 AM



The Knowledge Network for Biocomplexity

You can click and edit data directly within the table cells. After editing the data, click the 
"update" button to save the changes, or "cancel" to undo the changes. "Cancel" and 
"update" only apply to the changes made on the tab that is selected. To cancel changes that 
have been made to ALL data panels, you can select "Revert all tabs" under the "Data" menu 
at the top of the window.
 
You can right-click on the data table to bring up a menu which allows you to:
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●     sort columns
●     insert and delete rows 
●     insert and delete columns
●     add new tables
●     add/edit documentation

These same options are also available under the "Data" menu at the top of the window. 
Read more about using these tools here.
 

●     Table Documentation Panel

The table documentation panel (located to the right of the data table) displays 
documentation for the table that is currently being viewed. Note that tables are also referred 
to as "entities" in Morpho, using terminology consistent with database management 
systems. Similarly, "attribute" refers to the variables or columns contained within a table. 
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Clicking on any of the column headers in the table will cause the documentation panel to 
show more specific information about the selected column (or "attribute"). An example of 
this more detailed information about a sample column of data is shown below.
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You can return to the table (entity) documentation either by using the "back" button (located 
at the top left corner of the panel), or by clicking on the data table tab at the bottom of the 
data table panel.
 
You can edit the currently displayed documentation by clicking the "edit" button (located 
beneath the "hide'" button). Doing so will open the Morpho Editor, described in a later 
section.
 
As with the other panels, this panel can be resized by dragging the dividing bars, and can 
be hidden or expanded fully by clicking the arrows on the divider bars, or by clicking the 
"hide" button at the top-right corner. 
 
The next section describes how to open an existing data package.
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Opening an Existing Data Package

 
There are three equivalent ways to open an existing data package. Do one of the following:

●     Click the open button    found on the toolbar of the Main Welcome Screen.
●     From the File menu, choose "open". 
●     Click on "Open an existing data package" on the Main Welcome Screen.

 
You will then see a listing of the available data packages. The data packages listed are 
those which you have previously created using this profile and/or under the particular KNB 
username, along with a fictitious sample data package that comes with Morpho-- 
"Population sampling data for zooplankton in the Great Lakes, 2000".
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The icons in the first column of the "open" screen tell you if the package contains: 

Data and documentation Documentation only 

 
Icons in the last two columns indicate whether the package is located on the local machine 
or on the network (or both). 
Select a data package to open (or open the fictitious sample package "Population sampling 
data for zooplankton in the Great Lakes, 2000"). Click the "open" button located at the 
bottom right of the window, or double-click the selected data package, or right click on the 
data package and select "open".
 
To locate and view data packages other than those you have created, use the Search 
feature, which is described further in the next section.

 

Help Index Introduction to Data Packages       Searching for 
Data Packages
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Searching for Data Packages

 
There are three different ways to search for a data package. These are the subject search, the 
taxonomic search, and the spatial search. Each allows you to use different criteria in your search. You 
may combine features from one or more of these three types of searches into one search.
 
To begin a search for data packages, do one of the following:

●     Click the search button   found on the toolbar on the Main Welcome Screen.
●     Click on "Search for an existing data package" on the Main Welcome Screen.
●     Go to the "Search" menu at the top of the Main Welcome Screen, and select "Search".

! NOTE: if you are not logged in but have network access, the only network data packages that will 
show up in your search are those which have "public" access privileges. To view additional data sets 
from the KNB network, log in on the Main Welcome Screen.
 
Search Interface
 
Next, you will see the search interface, pictured below.
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You can name the search by typing in the field next to "Query Title", and then save the search and its 
parameters for later use. Save the search by clicking the "save search" button in the toolbar at the top of 
the screen, or selecting "Save Search" under the "Search" menu at the top of the screen. After you save 
the search, you can access it directly from the "Search" menu on the main menu bar at the top of each 
window.
 
Check the appropriate boxes at the top right of the search interface to specify where you would like to 
search. You may choose whether you want the search to occur only locally (i.e. on your computer), in 
the catalog (i.e. on the KNB network), or both. 
 
The four tabs (Subject, Taxonomic, Spatial, Options) provide more detailed search criteria. After 
entering your search criteria in one or more of these tabs, you have the option of combining all of the 
search criteria from all tabs to constrain your search further than if you were only to use the constraints 
from one tab. This can be accomplished by checking the "Combine constraints from all tabs" box at the 
lower left of the search interface. Each of the four tabs are described below.
 
Subject Tab
The first tab that is displayed is the Subject tab. This tab allows you to search for specific text in the 
documentation of the data packages.
 
You begin by choosing which data package documentation field or fields will be searched. Next, you 
choose whether the selected documentation field(s) either contains, starts with, ends with, or equals 
what you type in the blank field to the right of the window.
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By clicking the "More" button located at the lower middle of the window, you can create additional 
search panels for other terms in the documentation fields. Clicking "Fewer" will take away the extra 
fields. 
 
You then choose "And" or "Or". Choosing "And" makes the search return data packages that contain 
matches for EVERY ONE of the terms you specified in the fields. Choosing "Or" makes the search 
return data packages that contain matches for ONE OR MORE of the terms you specified in the fields.
 
As an example, examine the screen below. Here, the "More" button has been used to create two 
'Subject' search criteria. The top search criteria will look for items where the "Title" "starts-with" the 
phrase "NCEAS", while the lower region indicates the "Abstract" should "contain" the word "fish". These 
two search criteria are to be logically "OR"ed as indicated by the button near the bottom of the screen. 
Click "Cancel" to exit the search interface.
 

 
Taxonomic Tab
The next tab is the Taxonomic tab, which allows you to search for data packages associated with a 
certain taxonomic rank and value. 
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You choose whether your selected taxon rank either contains, starts with, ends with, or equals what you 
type in the blank field to the right of the window. For example, you may search for the taxon rank 
"Species", and specify that the species name contains "Neotoma".
 
By clicking the "More" button located at the lower middle of the window, you can search for additional 
taxa in the documentation fields. Clicking "Fewer" will take away the extra fields. 
 
As with the Subject tab, you can choose "And" or "Or" criteria if searching for more than one taxa. 
Choosing "And" makes the search return only data packages that match EVERY ONE of the taxa you 
specified. Choosing "Or" makes the search return any data packages that match ONE OR MORE of the 
taxa you specified. Click "Cancel" to exit the search interface.
 
Spatial Tab
The next tab is the Spatial tab, where you search for data packages based on a geographic area you 
specify. 
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You may search for data packages with a spatial coverage within a spatial area by drawing a bounding 
box on the map with your mouse. You can create a "bounding box" like the one shown over the United 
States by clicking somewhere on the map and then dragging with the mouse still pressed. Releasing the 
mouse will then complete the action and create a white rectangle like that shown. The latitude and 
longitude values indicated by the sides of the box are shown in the text boxes on the right. The box can 
be resized by dragging one of the white squares on the corners, or repositioned by dragging the white 
square in the center.
 
To draw a more precise bounding box, you can zoom into an area of the map to see more detail using 
the "Zoom In" button. Return to the previous views using the "Zoom Out" button. 

When the "Search" button is clicked, data packages will be queried to find those packages that contain 
geographic latitude/longitude coordinates inside (and overlapping) the indicated bounding box. Click 
"Cancel" to exit the search interface.
 
Additional Options Tab
The final tab, "Options", allows you to specify whether the search should be case sensitive (meaning 
only data packages containing the exact case for which you typed in the search fields will be returned). 
Also, on this tab you may specify if you would like to include taxon synonyms from the Integrated 
Taxonomic Information System (ITIS) in the search.
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Search Results
After entering your search criteria, choosing any additional options, and clicking "Search", your results 
are displayed as a set of data packages which met your search criteria. An example is shown below. 
Open the data package you would like to view either by double-clicking on it, right-clicking and selecting 
"Open", or selecting the desired data package, and then clicking the "Open" button in the main toolbar at 
the top of the window.
 

The icons in the first column of the search result screen tell you if the package contains: 

Data and documentation Documentation only 

 
Icons in the last two columns indicate whether the package is located on the local machine or on the 
network (or both). 

  Three buttons are now active in the main Morpho toolbar, and allow you to refresh the 
search, save the search for future use, or revise the search by changing the search parameters. These 
options are also available from the main "Search" menu located at the top of each window.
 
Learn how to create a data package of your own on the next screen.
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Creating a New Data Package

 
This chapter will describe the important task of creating a new data package, which is necessary if you want to document 
(create metadata for) your own data.
There are three equivalent ways you can begin to create your own, new data package. Begin by doing one of the following:

●     Click the new data package icon  in the main toolbar.
●     Click on "Create a New Data Package..." on the Main Welcome Screen.
●     Under "File", choose "New Data Package".

 
You will then be presented with the Data Package Wizard, a handy and powerful utility which enables you to collect the 
general information and basic descriptions about your data. Morpho uses the resulting documentation to generate your data 
package. 
 
Data Package Wizard
 
The Data Package Wizard will help you create the minimum amount of documentation necessary for a Data Package. This 
process consists of 14 simple steps, each involving a separate screen. The Package Wizard alerts you to fields that are 
required by coloring their label red. However, the more documentation (i.e., metadata) you provide, the easier it will be for 
scientists (including you!) and the KNB network to understand and utilize your data package. If you do not fill in a field whose 
label is colored red, you will receive a reminder message and will not be allowed to continue. Remember, you can always 
change the required or any other information at a later time using the Morpho Editor. See the later section, Editing a Data 
Package, for details on this.
 
Throughout the Data Package Wizard, instructions for filling out fields on each screen will be shown. It is recommended that 
you read the explanatory text of any Morpho screen.
 
Each of the Data Package Wizard screens are displayed and explained below. You go from one screen to the next, or back to 
a previous screen, using the "Next" and "Back" buttons. Hit "Cancel" to cancel the creation of the new data package.
 
The first screen of the data package wizard lists the types of information you should gather (or have in mind) before beginning 
to create a new data package. This screen is pictured below.
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You enter the title and an abstract for the data package on the next screen. The data set title is required. The abstract is 
optional, but is one of the most useful portions of the data documentation for those who may view the documentation in the 
future, and therefore it is highly recommended that an abstract be included. You may type the abstract directly into the field, 
or paste it in after creating it elsewhere.
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Clicking "Next" brings you to the Keywords screen. One or many keywords can be entered by clicking "Add".
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Clicking "Add" brings you to the screen pictured below. Click "Add" to add a keyword. Click "Add" again to add another 
keyword. You may delete a keyword you have entered by selecting it and clicking "Delete". You can also alter the order of the 
keywords by using the "Move Up" and "Move Down" buttons while the keyword you wish to move is selected.
 
If the keywords are taken from a predefined list, such as a thesaurus, then click on the circle next to "These keywords are 
chosen from a predefined list", and type the name of the source in the box that appears. Otherwise, click "OK" when you are 
done adding keywords. You will then be shown the list of keywords you have created in the screen that is pictured above. To 
add another, entirely separate list of keywords, click "Add" and repeat the steps described above to create another keyword 
list. You can also use the "Edit", "Delete", "Move Up", and "Move Down" buttons to edit, delete or change the order of the 
keyword lists. When you are finished adding keywords and keyword lists, click "Next" at the bottom of the screen.
 

 
You will then see the screen pictured below which lists the information that can be entered in the next few screens. Read the 
screen, and click "Next".
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Click "Add" on the next screen (pictured below) to add information about the data set owners.
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The "Owner Details" screen, pictured below, is where you can enter name, address, contact, and other information about the 
owner of the data set. Alternatively, you can choose an entry that you have already made previously by choosing it from the 
drop-down list at the top of the screen. This drop-down list includes an option to choose a previous entry made in a different 
data package, where you will be presented with a list of data packages and thier owners, and you can select one from the list. 
One of the three fields shown in red must have information entered into it to proceed. Click "OK" when done.
 

 
You will then be presented with a screen which will display the information you have entered. You may add additional owners, 
delete owners that are listed, edit entries, or change the order of the owners using the buttons on the right of the screen. Click 
"Next" when you are finished entering the owner or owners' information.
 
Next, a screen similar to the one used for entering information about the data set owner will appear, except that this screen is 
used to enter information about the contact for the data set. This person or organization may be the same as the owner, in 
which case you can choose the appropriate owner from the drop-down list at the top of the screen. Otherwise, enter the 
information for the contact into the fields, and click "OK". Just as before, you will then be shown the contact person you 
entered, and have the ability to add additional contacts, delete contacts listed, edit entries, or change the order in which the 
contacts appear in the list. Click"Next" when you are finished entering the contact(s) for the data set.
 
The next screen, pictured below, allows you to enter information for associated parties (people, organizations, etc.) 
associated with the data set. Clicking "Add" will bring you to a screen where the information about the associated party can 
be entered. It is similar to that used to enter information about the data set owner and contact. Similarly, after clicking "OK", 
you may add additional associated parties, edit entries, delete entries, and change the order of entries in the list. Click "Next" 
at the bottom of the screen when you are finished adding associated party information.
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You will then be presented with the following screen. Click the box if the project associated with the data set is part of a larger 
project. Leave the box unchecked otherwise. If it is associated with a larger project and you click in the box, you will be 
prompted to enter the name of the larger project, its funding source, and one or more personnel associated with the larger 
project. Click "Next".
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The next screen allows you to enter a description of the usage rights of the data package. You may type directly in the field, 
or paste in a paragraph of text created elsewhere. Click "Next" when finished with this screen.
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In the next step of the Data Package Wizard (pictured below), you have the ability to enter information about the geographic 
coverage of the data. Click "Add" to add a geographic coverage documentation.
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You will then be presented with the screen pictured below. You may type a textual description of the spatial coverage of the 
data in the first field (or paste a description in from elsewhere). In addition, you can specify the geographic coordinates of the 
coverage. There are three options for choosing the geographic coordinates. For any of these options, click "Zoom In" or 
"Zoom Out" to change the view of the map. Do one of the following:

●     Create a bounding box by selecting "Box Tool" and dragging the mouse on the map. You can then adjust the edges of 
the box by selecting and dragging the white squares located on the edges of the bounding box.

●     Select a point on the map be selecting "Point Tool" and clicking on the map.
●     Select a predefined region or point by selecting one of the choices in the list of Named Regions at the bottom of the 

screen. To add a named region so that in the future it will appear in this list, select the region or point on the mao, and 
click "Add". To remove a named region from the list, select the region and click "Delete". You can also "Sort" the items in 
the list.

After doing any of these options, the coordinates for the bounding box or for the point will be displayed on the right of the 
screen. Click "OK" when finished adding the documentation or selecting the coordinates for the geographic coverage. You will 
then be returned to the screen pictured above, and your documentation will be listed.
 
You may add additional geographic coverage documentation by clicking "Add" again on the screen pictured above. As before, 
you can edit, delete, or change the order of the geographic descriptions you have entered.
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You will next be prompted to describe the temporal coverage of the data set. Click "Add" to add a temporal coverage 
description.
 

file:///C|/work/morpho/docs/user/Creating_a_new_data_package.htm (11 of 22)4/18/2004 7:59:28 AM



The Knowledge Network for Biocomplexity

 
You will then see the screen below. There are two options for selecting a temporal coverage for your data. Do one of the 
following:

●     Select "Single Point in Time" for a temporal coverage of a single year, month, or day.
●     Select "Range of Date/Time" to specify a starting and ending of the temporal coverage of the data.

After choosing either of these options, select whether you want to specify the year only, the month and the year, or the day, 
month and year. Next, choose the appropriate temporal coverage in the calendar displayed. You may use the arrows to 
select the month and year, or you can type the month or year into the appropriate fields. To select a day, click on that day in 
the calendar pictured. When selecting a date/time range, make sure to select the start date/time on the left calendar, and the 
ending date/time on the right calendar. If the data is still being collected or added to, and therefore there is no end date/ time 
for the data set, then leave the right hand calendar blank.
 
Click "OK" at the bottom of the screen when finished. You will be shown your temporal coverage entry on the screen pictured 
above. You may add another temporal coverage for the data set, or edit, delete, and change the order of existing entries in 
the list. Click"Next" when finished adding temporal coverage information.
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You will then see the screen pictured below which is where taxonomic coverage documentation can be entered.
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There are two ways to add taxonomic information to the documentation. One is to type in the fields shown in the screen 
above to add taxonomic coverage for one or two taxon ranks (such as genus and species). To add additional levels of 
taxonomic information, click on the "Edit" button. You will then see the screen pictured below, where you can specify the 
name and common names for various taxonomic ranks. When finished, click the "Add" button. You may also delete an entry, 
or change the order of entries using the buttons located at the right of the screen.
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The second way to add taxonomic information is to click on "Import Taxon Information from Data Table". This data table must 
be one that you have already added to the data package in Morpho (see Adding Data to a Data Package for information on 
how this is done). If you have not yet added a data table to the data package, ignore this option for now - you can always add 
data and documentation for the taxonomic coverage later (click here to read how). If you click on the import taxon information 
link after adding data to the data package, you will see the screen pictured below.
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These column are from a data table in a fictitious sample data package that comes with Morpho. This feature can be used to 
select taxonomic names from a data table which contains a column of taxonomic information, which will speed the input if 
taxonomic information into the documentation. Begin by choosing which columns of taxonomic information you wish to import 
by checking the box of that column. Notice that a pop up box will prompt you to choose the taxon rank that the values in the 
column correspond to. Next, decide whether all of the values in the selected column(s) will be imported, or if only certain 
values which actually appear in the data are to be imported. Finally, click "Import".
 
You will then be returned to the previous screen, where the taxonomic information will be displayed. You can then add 
additional taxonomic information, or edit or delete selected information. You may also specify what taxonomic classification 
system is used for the taxonomic information by clicking the box at the bottom left of the screen and typing in the name of that 
system. Click "OK" when finished, and then "Next".
 
You will then be prompted to describe the methods, study extent, and sampling description, on the screen shown below. 
Each of these can be typed directly into the fields or pasted in from elsewhere.
 
Methods can be described in a single or multiple steps. To add a description of the method as a whole, or the first step in the 
method, click "Add". You will then be prompted to enter a method title (optional) and a method description. Click "OK" when 
finished entering the method title and /or description. The method will be displayed in the list on the screen pictured below. 
Click "Add" again to add another method or method step. You can also edit, delete, and change the order of methods or 
method steps you have entered using the buttons on the right of the screen.
 
Enter information into study extent to supplement the information you already provided on the temporal or spatial extent of the 
study. For example, missing years for temporal coverage should be noted here, or a description of temporal coverage for 
data sets beyond the calendar range provided previously (such as "the pleistocene").
 
Finally, in the sampling description field you can provide detail on the sampling design of the study. Click "Next" after 
describing methods, study extent, and sampling description as you would like.
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The next screen allows you to control the access to your data and the data set. First, indicate whether or not you would like 
the public to be able to read your data package documentation once it is placed on a network (which is described in the 
section Uploading and Downloading Data Packages).
 
You may then specify specific people and detail the permission you wish to grant them for the data package. Click"Add" if you 
wish to specify access rights for these people.
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Defining the people and their access rights is accomplished on the screen pictured below. Begin by browsing through the list 
of groups and users on the left of the screen. You can expand the list by clicking on the plus sign next to the group, or shrink 
the list back to its original form by clicking refresh at the bottom of the screen.
 
After selecting a specific user, you will be prompted to type in their name, organization,and email address. Next, define their 
access permissions on the right of the screen. Choose Allow or Deny, and then Read, Read and Write, Read and Write and 
Change Permissions, or All from the drop down menus. If you are unsure about what each of these means, read the 
description of each at the bottom of the screen. Click "OK" when you are finished defining access for one user.
 
You may define access for additional users by clicking"Add" again on the screen pictured above. As before, you can also edit, 
delete, or change the ordering of entries you have made by using the buttons on the right of the screen pictured above. Click 
"Next" when finished.
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The final screen of the Data Package Wizard is pictured below. Congratulations - you have created a rudimentary data 
package documentation! Click "Finish" to view the documentation. Alternatively, you may add an actual data object, such as a 
table or an image, at this step in the Data Package Wizard by choosing "or click here to finish this wizard and add a new data 
table now...", or you can do this at a later time. Either way, read the section titled Adding Data to a Data Package for 
instructions on how to do this.
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The data package shown below is an example (for a fictitious data set with no data added to it) of what your data package 
would look like after finishing the Data Package Wizard. Note that there are different panels in the documentation.
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Alternatively, on the final screen of the Data Package Wizard, before clicking "Finish", you may click on the link at the bottom 
of the screen which says "or click here to finish this wizard and add a new data table now..." to add data to your data 
package. You may also add data later on at any time (go to Adding Data to a Data Package for a description of how to do 
this).
 
After creating your data package, you can edit it or add additional information about your data, using the Morpho Editor. Go to 
a later section for a description of how to do this.
 
You can also access, edit, and add to major portions of the documentation at any time by looking under the Documentation 
menu, pictured below. You may edit or add any type of documentation by selecting "Add Documentation..." which will take 
you to the Morpho Editor (read about using Morpho Editor here), or add or edit specific types of documentation by choosing 
one of the other five choices.
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The next section describes how to add data to your data package.

 

 

Help Index Searching for Data Packages       Adding Data to a Data 
Package
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Adding Data to a Data Package

 
New Data Table Wizard
There are two alternate ways to add a data table to a data package in Morpho. One way is to click on "or click here to 
finish this wizard and add a new data table now..." at the end of the Data package Wizard, shown below.
 

 
Alternatively, after creating a data package, you can select Create/Import New Data Table under the Data menu at the 
top of the window, shown below.
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Either way you will see the New Data Table Wizard, which is described below. Throughout the New Data Package 
Wizard, items in red are required. The first screen of the New Data Table Wizard is shown below. 
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Begin by choosing one of the three options to tell the wizard what you would like to do. Each of these is described 
below.

●     CREATE

An empty data table is created where you can type the data directly into Morpho. You also manually create 
documentation for the data table.

●     IMPORT

An existing data file is imported into Morpho, and you create the documentation for the data using the wizard, either 
automatically or manually. 

●     DESCRIBE

The data are NOT included in the data package, but you create the documentation for the data using the wizard, either 
automatically or manually.
 
Depending on which of these first three options you choose, you will see different subsequent screens and provide 
different information throughout the New Data Table Wizard. Each of these three alternate paths is described below.
 
Create
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File Format
If "CREATE" is selected in the screen pictured above, you will create a new data table that is empty, where you can 
type the data in later, and you will also create documentation (metadata) for the table. Clicking "Next" will bring you to 
the screen pictured below, where you indicate the format of your data.

 
If the data is in a simple delimited text format, then choose the first option. You will then see the additional prompts 
shown below. Indicate if the data attributes are arranged in rows or columns. Then choose one or more delimiters 
used in the formatting to indicate where the end of fields occur. 
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If instead the data are in a complex text format, choose the second option. You will then see the additional prompts 
shown below. Indicate if the data attributes are arranged in rows or columns. You then can define whether the data 
contain fixed width fields, and if so what the width is, or of the data are delimited, and if so what the delimiter character 
is. You may add additional data structure documentation to this list, delete existing ones, or change the order of them, 
by using the buttons to the right of the screen.
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If the data are not in simple delimited text format or in complex text format, but are instead a Microsoft Excel file, then 
choose the third option under "What is the format of your data?". Additional prompts will then appear, shown in the 
screen pictured below. Choose one of the format types from the list. If the format of your data are not shown, then click 
"Other" and describe the format on the space provided.
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Click "Next" when finished describing the file format. You will then see a screen which asks you to describe the data 
table, also known as an "entity", pictured below.
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Begin by typing the name of the table, which is required. Add a description of the entity (table) if desired. This will be 
helpful in informing future viewers of the data package abut the contents of the table, and will also serve to document 
the overall meaning of the table as well, and therefore adding a description is recommended. Next, you define the 
attributes of the data table in a number of ways. Only one attribute is required to be defined, but it is highly 
recommended that ALL attributes be defined. Click "Add" to define one of the attributes. You will then see the screen 
pictured below.
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Begin by naming the attribute (which is often simply a column in the data table, but not always), and providing a label 
for the attribute (which should be shorter than the name). In the "Definition" field, provide a precise and descriptive 
definition of the attribute. This is probably the most important part of defining the attribute because it is where you 
provide information so that future viewers or users of the data can understand what the attribute means or represents. 
Next, choose the type of measurement scale for the data in the attribute in the "Category" section. Click "Help" for 
further explanation of each of these categories. Each measurement scale is also described below.

●     Unordered (Nominal)

The unordered, or nominal, scale places values into named categories. The different values within a set are 
unordered. Text fields should be classified as nominal. Examples of unordered, or nominal, scales include gender 
(Male/Female) and marital status (single/married/divorced). 

●     Ordered (Ordinal)

The ordered, or ordinal, scale places values in a set order. All ordinal values are also nominal. Ordinal data show a 
particular value's position relative to other values, such as "low, medium, high, etc." The ordinal scale doesn't indicate 
the distance between each item. Examples of ordered, or ordinal, scales include level of agreement (Strongly agree, 
Agree, Disagree, Strongly disagree), or age class (Adult, Sub-adult, Juvenile).

●     Relative (Interval)

The relative, or interval, scale uses equal-sized units of measurement on a scale between values. It therefore allows 
the comparison of the differences between two values on the scale. With interval data, the allowable values start from 
an arbitrary point (not a meaningful zero), and so there is no concept of 'zero' of the measured quantity. Consequently, 
ratios of interval values are not meaningful. For example, one can not infer that someone with a value of 80 on an 
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ecology test knows twice as much ecology as someone who scores 40 on the test, or that an object at 40 degrees C 
has twice the kinetic energy as an object at 20 degrees C. All interval values are also ordered and therefore are ordinal 
scale values as well. Example of relative, or interval, scales include the celsius temperature scale and the fahrenheit 
temperature scale.

●     Absolute (Ratio)

The ratio scale is an interval scale with a meaningful zero point. The ratio scale begins at a true zero point that 
represents an absolute lack of the quality being measured. Thus, ratios of values are meaningful. For example, an 
object that is at elevation of 100 meters above sea level is twice as high as an object that is at an elevation of 50 
meters above sea level (where sea level is the zero point). Also, an object at 300 degrees Kelvin has three times the 
kinetic energy of an object at 100 degrees Kelvin (where absolute zero (no motion) defines the zero point of the Kelvin 
scale). Interval values can often be converted to ratio values in order to make ratio comparisons legitimate. For 
example, an object at 40 degrees C is 313.15 degrees Kelvin, an object at 20 degrees C is 293.15 degrees Kelvin, and 
so the first object has approximately 1.07 times more kinetic energy (note the wrong answer you would have gotten 
had you taken the ratio of the values in Celsius). Examples of absolute, or ratio, scales include elevation, height, and 
the Kelvin temperature scale.

●     Date-Time

Date and time values in the Gregorian calendar are very strange to use in calculations in that they have properties of 
both interval and ratio scales. They also have some properties that do not conform to the interval scale because of the 
adjustments that are made to time to account for the variations in the period of the Earth around the sun (e.g. leap 
years). While the Gregorian calendar has a meaningful zero point, it would be difficult to say that a value taken on 
midnight January 1, 1000 is twice as old as a value taken on midnight January 1 2000 because the scale has many 
irregularities in length in practice. However, over short intervals the scale has equidistant points based on the SI 
second, and so can be considered interval for some purposes, especially with respect to measuring the timing of short-
term ecological events. Date and time values can be represented using several distinct notations, and so we have 
distinct documentation needs in terms of specifying the format of the value representation. Because of these pragmatic 
issues, Date-Time has been separated into its own measurement scale. Examples of date-time values are '2003-05-
05', '1999/10/10', and '2001-10-10T14:23:20.3'.
 
 
It is important to keep in mind that a given type of data may fall under more than one of these categories because the 
categories are nested (i.e. ordinal data are also nominal, interval data are also ordinal and nominal, and ratio data are 
also interval, ordinal, and nominal). This may make choosing one category confusing, so remember to pick the 
category as low in the list as you can that still accurately describes the attribute's data.
 
Choosing one of these five choices will bring about additional prompts, allowing you to describe the categories 
themselves, units, number types, and other details. You will encounter different screens depending on which category 
is chosen, and each of these screens is described and shown below. 
 
Unordered (nominal)
If "Unordered" is chosen, you will be first prompted to choose if the unordered categories are enumerated values 
belonging to a predefined list, or if they are text values (that are either free-form or that match a pattern). If you choose 
"Enumerated values", you will be promoted to choose if the location of the enumerated values. If you choose "Codes 
are defined here", you will see the screen pictured below. Click "Add" to add a code and its definition. For example, in 
your data table there may be values such as "M" and "F", which stand for male and female, respectively. Therefore M 
and F would go under "Code", and Male and Female would go under "Definition" in the table at the bottom of the 
screen.
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Alternatively, you can choose to have the enumerated values (codes and their definitions) imported from elsewhere, in 
which case you will see the screen pictured below. At the right of the screen there is a button labeled "locate" which 
allows you to tell the New Data Table Wizard where the enumerated codes list is located.
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Clicking the "locate" button brings you to the screen pictured below. To import the codes later, choose the first option, 
"Import the definitions table into Morpho later", and click "OK" at the bottom of the window.
 
Alternatively, if the codes and their definitions are already contained in the data table you imported in the New Data 
Table Wizard, then choose the second option, "The definitions table has already been included in this package". An 
example of what you will see when this second option is chosen is pictured below for a sample data table. Choose the 
two columns which contain the codes and their definitions by clicking the check boxes at the top of those columns, and 
then click "OK" at the bottom of the window. You will be returned to the screen pictured above and the selected codes 
and definitions will be displayed in the "Definitions" table.
 
Note the check-box at the bottom of the screen. Check this box if your columns of data contain free-text, such as notes 
for example, in addition to the defined codes you provide in the "Definitions" table. Click "OK" when finished defining 
the attribute or column.
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Another possibility is that the data in the attribute or column are unordered, but they are text values. In this case, 
choose "Unordered" from the "Category" list, and choose "Text values (free-form or matching a pattern)" from the drop-
down menu next to "Choose". Next, define the text values, and provide the name of their source, if applicable. You can 
also define the pattern of the text values by clicking "Add" at the bottom of the screen, and typing the pattern into the 
"Pattern(s)" table. You can then delete any patterns you would like using the "Delete" button. Click "OK" when finished.
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Ordered (ordinal)
If "Ordered" is chosen as the category, then the same prompts and choices that were just described for the 
"Unordered" category will be shown. Go through the same steps that were just described, or click here to jump to that 
section.
 
Relative (interval)
If "Relative" is chosen as the category, then you will be presented with a different set of prompts for documentation 
than described above. You will see the screen pictured below. Begin by choosing the type of measurement from the 
first drop-down list. Next, choose the appropriate unit in the drop-down list to the right. 
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You also have the option of defining a new unit by clicking the "Define new unit" button located at the right of the 
screen. This option is described in the next paragraph. 
 
To define a new unit, click on the button that says "Define new unit". You will then see the screen pictured below. You 
can either type in the unit type in the first field, or use the drop down list to choose the unit type from a list. Next, click 
"Add". You will see a drop-down list of unit types appear under "Unit". The idea here is to construct your new unit by 
defining the units it is comprised of, and the power of each component unit in the new unit. As an example, consider 
the new unit to be of the type "velocity". You would begin by choosing "velocity" under the Unit Type drop-down list. 
You would then click "Add" and choose "Length" from the drop down list found under "Unit". The power of that unit 
would be 1. You would click "Add" again and choose "Time" from the drop-down list under "Unit", and the power of that 
unit would be -1. Putting those two units together according to the indicated powers gives you a new unit of length/
time. 
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Next, you name the new unit. You also will specify the SI unit that corresponds to the new unit you have defined. If 
known, you can provide the conversion factor in the next field that would convert your unit to the SI unit. You can also 
provide a description of the new unit in the final field. Click "OK" at the bottom of the window when you are done 
defining your new unit.
 
After choosing or defining the unit, indicate the precision of the chosen or defined unit in the data by typing in the field 
next to "Precision". Next, choose the number type of the data from the drop-down list. See the next paragraph for 
further explanation in choosing a number type. Finally, you can indicate the bounds of the values in the attribute or 
column at the bottom of the screen. Click "Add" to do this, and type in the indicated information. Use "Delete" to 
remove a set of bounds you entered.
 
The four number types provided in the drop-down list are not discrete classes – some overlap, so choosing the 
appropriate number type can be confusing. Remember to choose the type that most specifically and accurately 
describes the data in the attribute or column you are defining.

●     Natural numbers

Natural numbers are positive and non-zero counting numbers (i.e. non-fractions), such as 1, 2, 3, and so on. They 
cannot be negative or zero. When thinking of counting numbers, think about counting a basket of oranges, or counting 
something using your fingers (although natural numbers can be larger than ten!). There are no fractions of oranges or 
fractions of fingers (hopefully!), and there are no negative numbers of oranges or negative numbers of fingers. Natural 
numbers are one type of whole numbers.
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●     Whole numbers

Whole numbers are just like natural numbers, except zero is included in the set of whole numbers, and therefore whole 
numbers are positive counting numbers and zero: 0, 1, 2, 3, and so on. Just like natural numbers, they cannot be 
fractions or negative. Whole numbers are a type of integer, and they include natural numbers.

●     Integer numbers

Integers are just like whole numbers, except negative counting numbers are included in this set. Therefore integers are 
positive and negative counting numbers and zero, such as -3, -2, -1, 0, 1, 2, 3, and so on. Just like whole and natural 
numbers they cannot be fractions. Integers are a type of rational numbers, and they include whole numbers and 
natural numbers.

●     Real numbers

Real numbers are the broadest set of numbers. They can be negative and positive fractions and counting numbers, 
and can include zero. Therefore a list of numbers like the following would be a set of real numbers: -1/2, -0.25, 3.14, 0, 
1, -25, 5/8, and so on. As you can see from this list of examples, real numbers include integers, whole numbers, and 
natural numbers.
Absolute (ratio)
Choosing "Absolute" as the data category will take you through the same set of choices and prompts as was just 
described above when "Relative" was chosen. Click here to read a description of this.
 
Date-Time
The fifth choice under "Category" is "Date-Time". If you choose this category, you will see the screen pictured below.
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Type the format of the date and/or time in the field next to "Format", using the examples given to the right of the field 
as a guide (although formats other than those shown in the examples may be used). Next, provide the precision of the 
date and/or time format. You may also indicate the upper and/or lower bounds of the date and/or time using the 
"Bounds" table at the bottom of the screen. Click "Add" to do this, and click "Delete" if you wish to remove a set of 
bounds you previously entered.
 
After choosing one of the five choices for "Category" that have been described here, and after filling out all of the 
required information and any additional information you wish to include at the bottom of the window, click "OK". You 
have just added a description of ONE of the attributes or columns of the data. You should then see the information 
displayed in the list of attribute descriptions in the screen pictured below. To describe another attribute or column, click 
"Add" again, and go through this process again for the new attribute you wish to define. After defining multiple 
attributes, you can delete the descriptions, or change the order of the descriptions, using the buttons to the left of the 
screen. 
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After you have added all of the attribute documentation you would like to, click "Next" at the bottom of the screen. You 
will then see the final screen of the New Data Table Wizard, pictured below.
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Click "Finish" to finish the documentation of the data table, or click on "or click here to finish this wizard and add a new 
data table now..." to finish adding documentation of the data table and to add documentation for another data table 
using the New Data Table Wizard again. After clicking "Finish", you will then be presented with a data package that 
shows an empty data table, documentation for the attributes or columns of data that you just added using the New 
Data Table Wizard, and any documentation you had added previously using the Data Package Wizard. You can now 
type the data directly into the columns in the empty data table, or paste the data into the data table from elsewhere.
 
Import
On the first screen of the New Data Table Wizard, you are given three choices under "Where is your data?". If 
"IMPORT" is selected, you will then see additional prompts, shown in the screen below.
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Under "How do you want to enter the metadata description", there are two options. Automatic is where the 
documentation for the data table is automatically extracted from the table itself by Morpho, and is shown to you for 
review and editing, if necessary. Manual is where the documentation is entered manually by you in the wizard. After 
choosing one of these two options, tell the wizard where the data is that you would like to import by clicking on 
"locate...". You will be shown a map of your computer and can indicate where the data file is. Click "Next" after 
choosing the file location.
 
If you chose to document the data manually, then you will follow the steps that were outlined previously under the 
"Create" section above (start here). 
 
If you chose to document the data automatically, then clicking "Next" will being the screen pictured below into view. 
The screen includes some sample data shown for illustration purposes. Your data might look quite different.
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Begin by entering the name and a brief description of the data table. Indicate which row you would like the importation 
of data to start at (for example, you can skip some blank rows that may occur at the top of your data table by starting 
at a later row). If the first row that you start at contains the column labels, then click the box in the middle of the screen. 
Click "Next". You will then see the screen pictured below.
 

file:///C|/work/morpho/docs/user/Adding_Data_to_a_Data_Package.htm (22 of 33)4/18/2004 7:59:32 AM



The Knowledge Network for Biocomplexity

 
Select one or more of the delimiters listed at the top of the screen. Choosing different delimiters will change the layout 
of your data. The data should be laid out correctly when the correct delimiter or combination of delimiters is chosen. 
You may also indicate that consecutive delimiters be counted as one by checking the box. Clicking "Next" will begin 
the process of verifying the documentation that Morpho has automatically generated for each of the columns in the 
data table. The screen pictured below is an example of what you might see. 
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Another example is shown below. Note that Morpho automatically placed the codes in the table under "Code", but you 
have to provide the definition of the codes. You must also provide definitions of the columns (Morpho does not do this 
automatically). Examine all of the other areas of documentation, making sure that the category, units, and all other 
documentation is correct. You may also add to the documentation or change anything that is in error by typing in the 
fields shown or choosing selections from the drop-down menus. Click "Next" at the bottom of the screen. Each screen 
provides the documentation for one of the attributes or columns of data. Continue in this way until all of the attributes 
or columns have been documented.
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When all of the columns of data have been documented, you will see the final, finish screen, pictured here.
 
Describe
On the first screen of the New Data Table Wizard, you are given three choices under "Where is your data?". If 
"DESCRIBE" is chosen under "Where is your data?", the data itself will not be included in the data package, but you 
will provide documentation for it. This is useful for documenting the data for yourself, as well as for telling others about 
the data if the data package is made viewable by others, without sharing the data itself. 
 
If "DESCRIBE" is selected, then additional prompts will appear on the screen, pictured below. To have the 
documentation for the data extracted automatically from an existing data file (without the data itself being extracted) for 
your review, then choose "AUTOMATIC". You will then tell the Wizard where the data file is. Instructions for what to do 
next if you choose AUTOMATIC have already been provided above (click here).
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To manually enter the documentation for the data in the Wizard, choose "MANUAL". You will then be prompted, as 
shown on the screen pictured below, to indicate where the data resides. If the data are not currently available, then 
choose "Not available". 
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If the data are available online, then choose "Online URL", and type in the file name and URL in the spaces provided, 
as shown in the screen pictured below.
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If the data are archived, such as on a disk or a hardcopy, then choose "Archived", and provide the medium the data is 
found in or on, as well as the name or title of the data, in the spaces provided (pictured below).
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After finishing making selections and filling out fields on the first screen of the New Data Table Wizard, click "Next" at 
the bottom of the screen to continue. Instructions for what to do next if you choose MANUAL have already been 
provided above (click here).
 
Importing and Documenting Other Data Types
Although the New Data Table Wizard is designed for importing and documenting tabular data, it can also be used to 
import and document other types of data, such as images. To do this, you would choose "IMPORT" (or "DESCRIBE" if 
you do not want to include the image but do want to create documentation) on the Data Location screen, pictured 
above. You would then choose "MANUAL" metadata entry (since there is no data table from which Morpho can 
automatically extract the data). Indicate where the data file is located, and then click "Next" at the bottom of the 
screen. ON the file format screen, you would choose the third option "Non-text or proprietary formatted object that is 
externally defined", choose "Other", and type in the file type (such as .gif or .jpeg). Continue on in the New Data Table 
Wizard, filling out the applicable documentation fields (such as name and description) and ignoring or filling in "none" 
for fields that don't apply to the image. See more about including images in a data package here.
 
Manipulating Data Tables
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Once you have either created or imported a data table or multiple data tables in Morpho, you can then edit and 
manipulate that data. Under the "Data" menu there are a number of tools to help you do this. They are shown in the 
screen below. You can also access this same set of tools by right-clicking on the desired row or column.
 

 

●     Sorting

To sort the rows of a data table, select the column which you would like to sort by, and click "Sort by Selected 
Column". For example, in the sample data set pictured above, the second column, "site", was selected, and then "Sort 
by Selected Column" was selected from the "Data" menu. The results are pictured below. Notice that the data in the 
second column is now sorted, and the data in the other columns have also moved so that all of the rows are the same 
as they were, only moved.
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●     Inserting and Deleting Rows and Columns

The next six items under the "Data" menu allow you to insert new rows or columns, either before or after the row or 
column that is selected in the table, as well as delete selected rows or columns. This works much like the same 
functions in MIcrosoft Excel.

●     Editing Column Documentation

In addition to manipulating the rows and columns, you can directly edit the documentation that you previously entered 
in the New Data Table Wizard, or add documentation, about the columns. After selecting the column for which you 
would like to edit the documentation, look under the "Data" menu, and select "Edit Column Metadata". You will then 
see a screen, pictured below for the second column of the sample data set, where the current documentation for the 
column is displayed. This screen works just like it did in the New Data Table Wizard (click here to revisit this section). 
You can edit or add to the documentation shown in this screen, and click OK when finished. 
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●     Cut, Copy and Paste

Cut, copy, and paste, which can be accessed under the "Edit" menu (pictured below) work in Morpho just like they do 
in Microsoft applications like Word and Excel. Shortcut keys on your keyboard can also be used just like in Microsoft 
applications (Ctrl+X cuts, Ctrl+V pastes, and Ctrl+C copies). You can relocate or delete rows and columns using these 
tools.
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Another option is to paste data into a data table in Morpho from elsewhere, so that you don't have to type it in. This is 
easy to do, and generally involves using the "Paste" command in Morpho. Click here to read more about pasting data 
into a data table. 

●     Reverting (undoing changes)

If you change your mind about any of the changes you have made to one or more tables in your data package, you 
can undo these changes (as long as you have not saved the data package since making the changes). Under the 
"Edit" menu, choosing "Revert Tab" will cause all changes that have been made on the table that is displayed since 
the last time you saved the data package to be reversed. Choosing "Revert All Tabs" causes all changes that have 
been made to all of the tables in the data package since the last time you saved the data package to be reversed. The 
location of these two tools is shown in the screen above.
 
 
The next section of the Morpho User Guide describes editing a data package.

 

Help Index Creating a New Data Package       Editing a Data 
Package
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Morpho User Guide

 

Help Index Adding Data to a Data Package       Uploading and Downloading Data 
Packages

Editing a Data Package

 
There are two main reasons you may wish to edit a data package. First, you may want to add additional 
documentation to the data package documentation, that was not available in the Data Package Wizard. Second, 
you may want to change or delete documentation that you entered in the Data Package Wizard, or that you added 
to the data package documentation in some other way. For either of these purposes, you can use either the Morpho 
Editor, or use the selection available under the Documentation menu at the top of each window. The functions and 
uses of the Morpho Editor are described below, and the Documentation menu is described later (click here to skip 
ahead).
 
Morpho Editor
Begin by opening the data package you wish to edit. Next, open Morpho Editor by doing ONE of the following:

●     Under the "Data" menu, choose "Add Documentation".
●     Under the "Documentation" menu, choose Add/Edit Documentation"
●     On the upper right side of the data package documentation, click on the "Edit" button.

You will then see the Morpho Editor, pictured below.
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Each type of data documentation document (i.e. each metadata type) has some structure which is indicated by the 
hierarchical outline on the left. By clicking on the "+" symbol next to a category, you can browse through the 
hierarchy, viewing "parent" and "child" nodes. Parent nodes are the higher level nodes, and child nodes are the sub-
level nodes.
 
Items in the outline are color coded to indicate which items are required and which can be repeated. The legend for 
this color-coding is found at the bottom-left of the screen. Blue and red nodes in the hierarchy are required, while 
green and yellow nodes are optional. Blue and green nodes are repeatable, meaning they can be duplicated (for 
example, there can be multiple data set owners), while red nodes can only be used once, and yellow nodes can be 
used once or not at all (zero).
 
Initially, only the documentation types that already exist in the data package documentation are displayed in the list. 
When an item is selected in this outline, a form based view of the information contained in the selected item is 
shown on the right side of the window. You may navigate your way to a desired field that you would like to edit by 
clicking on the plus symbols next to the documentation types. Alternatively, you can scroll through the fields shown 
on the right half of the screen by using the scroll bar.
 
Most of the fields on the right side of the editor screen are editable. One can just click on the field of interest and 
enter text. The 'tab key' will move the selection to the next editable field.
 
To add additional documentation for types that are not shown initially in the tree on the left of the screen, click the 
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"Show All" button. This will cause all of the documentation types to be displayed. To get back to the original view, 
click "Trim".
 
To expand and view all of the levels of the tree, click on the "+" button at the top left of the screen. All parents and 
their children will be displayed. To contract the levels of the tree, click the "-" button.
 
A right-click on any item in the outline displays a popup menu (as shown below) which allows the user to choose 
among several options. These include duplicating an item, deleting an item, or copy and pasting items. Note that all 
of these operations will include not only the selected item, but also all of the item's children, or sub-levels, in the 
indicated hierarchy. 
 

 
To navigate quickly through the tree, you can find a section of documentation by choosing it from the drop down list 
located at the top left of the screen, next to "Find:".
 
The Documentation Menu
The Documentation menu, which can be found at the top of each screen in Morpho (see picture below), is activated 
when the Morpho user opens an existing data package. The Documentation menu options invoke various 
documentation editing tools and/or data entry screens that, together, enable the user to edit any field in the data 
package. As mentioned in the Morpho Editor section above, the first choice in the Documentation menu opens the 
Morpho Editor, which allows the editing of any field. The other choices in the menu bring up screens that allow one 
to edit or add data for specific subsections of the documentation. These same screens are used in the Data 
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Package Wizard to create a new data package, and therefore may look familiar. 
 

 
The Documentation menu options are (with screens pictured below):

●     Add/Edit Documentation: Invokes the full-featured Morpho Editor, giving the user editing access to all fields in 
the data package. 

●     View Documentation: Allows the user to view all the documentation for the data package in one window.
●     Research Project: Allows user to specifiy whether data is part of a larger research program. 
●     Usage Rights:Accepts a text paragraph that describes the intended usage rights for the 

data package. 
●     Geographic Coverage: Allows the user to specify and describe the geographic region

associated with the data package. 
●     Temporal Coverage: Accepts the specification of a temporal coverage boundries.
●     Taxonomic Coverage: Accepts a list of taxa to which the data package applies. 

●     Methods: Allows user to specify the method steps used to collect data, and describe 
the study extent and sampling area.

●     Access Permissions: Enablers the user to specify access rights to the data for 
specific persons, and to establish public access rights to view and/or edit the data. 

Click on any of the above menu options to read about how to fill out the screens.
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Following are sample screens from each of these options: 
 
Add/Edit Documentation:

 
View Documentation:
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Research Project:
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Usage Rights:
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Geographic Coverage:
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Temporal Coverage:
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Taxonomic Coverage:
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Methods:
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Access Permissions:
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Technical Notes
For those who are interested in technical details, the Morpho editor is an XML editor. It works by first reading an 
XML file and building an outline (tree) view of the XML document. XML files can have formalized templates called 
"DTD's", which describe how the document can be constructed. If the XML document indicates that its structure 
should conform to a DTD, then the DTD is scanned and a single instance of any optional nodes not present in the 
original is added to the hierarchy. Finally, if the editor has additional data about the document type, it will add that 
data as custom displays or help information about the node, as is shown in the above examples. The editor can 
thus be customized to display the XML data in a variety of ways.
 
Learn how to upload and download data packages in the next section.

 

Help Index Adding Data to a Data Package       Uploading and Downloading Data 
Packages
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Morpho User Guide

 

Help Index Editing a Data Package       Frequently Asked 
Questions

 

Uploading and Downloading Data Packages

 
Data packages, while created locally, can be uploaded to a network server, or downloaded from a network server to 
your PC, to become a shared network data package. 
 
Morpho Preferences
Begin by telling Morpho the location of the network. Go to "File", and select "Set preferences...". The following screen 
will appear.
 

 
Type the URL of the metacatalog, or network, in the first field. The other fields under Morpho Preferences can be 
used to control the look and feel of Morpho, the debug level (this affects the content of any error messages you may 
encounter in Morpho), and whether or not the error messages are logged. Click here for more information on these 
options. Click "Set" when finished setting preferences, or "Cancel" to undo.
 
Uploading to a Network
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There are two ways to place a data package you have created on a network. These are: saving the data package on 
the network, and synchronizing.
 
After creating a data package and setting the metacat URL, you can save the data package both locally and/or on a 
network by selecting "Save..." under the "File" menu, as pictured below.
 

 
You will then see the window below. Select "Local", "Network", or both, by checking the appropriate boxes, and 
clicking "Save".
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Data Packages can also be uploaded by choosing the "File" menu, then clicking "Synchronize". You will see the 
screen below when using this option. Click "Execute" after reading the screen.
 

 
Downloading from a Network
Similarly to uploading a data package, you can download a data package to your local PC from the network (that you 
specified in Morpho preferences) by first opening or searching for data packages, then right-clicking on a desired data 
package and selecting "Synchronize" (or through the same option on the "File" menu). The screen below shows how 
right-clicking brings up a menu of options.
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Notice you also have the option to delete data packages listed in the open or search results windows. You are only 
allowed to delete packages that you have created, or for which you have special permissions that the data package 
originator has defined. 
 
Note also the "Export" feature. This allows you to select a directory where you want the package exported to. Click 
here to read more about the export feature.
 
The next section are some Frequently Asked Questions, or "FAQs", about Morpho.

 

Help Index Editing a Data Package       Frequently Asked 
Questions
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Morpho User Guide

 

Help Index Uploading and Downloading Data 
Packages        

 

Frequently Asked Questions 

1. How do I get help?

If Morpho is running, you should be able to use the "Help" menu located at the top of each 
window. You can also open the "docs/user" directory in the directory where Morpho was 
installed and then open the file "index.html" in your browser (usually by double clicking on 
the file name). This will display the same help files as you would see when using Morpho's 
Help menu. The Morpho User Guide, found under the "Help" menu, contains information on 
a variety of topics and uses of Morpho. Examine the index to determine where to get help.

2. Where are my local data packages stored?  And what happens to my local data 
packages when I upgrade to a newer version of Morpho?

If you have used a previous version of Morpho, then you may have local data packages 
stored in a "profiles" directory inside the main Morpho data directory. The location where 
the "profiles" directory is created and accessed is in a subdirectory within the user's "home" 
directory. [On Windows 2000 or XP machines, the home directory is named after the user 
name (e.g. "higgins") and is located inside the "Documents and Settings" folder, 
usually under C:\] A directory named ".morpho" is created inside the user's home 
directory and the new "profiles" subdirectory is created there when Morpho is first 
executed. There is a subdirectory under "profiles" with the profile name and another 
subdirectory under that with the name "data" where local data for that profile is actually 
stored .  Note that this is (usually) not the same directory as the one where the Morpho 
executable is installed. You should thus be able to uninstall Morpho and update it to newer 
versions without fear of lossing any locally stored data packages.

3. How can I add an image to my data package?

Complex, geospatially indexed images can be included and described in eml 2.0 using the 
"spatialRaster" or "spatialVector" entitiy modules.  However, Morpho currently has no 
features directly supporting these modules. Nevertheless, images that are stored in .gif or .
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jpeg formats (standards for web pages) can be added to data packages as "dataTable" 
elements (even though they are not really 'dataTables'). To add such an image to an 
existing package using the "Create/Import New Datatable..." command under the "Data" 
menu. Choose the "Import" and then "Manual" radio buttons Then select the image file that 
you wish to include. Then click the "Next" button.  Select the "Non-text or proprietary 
formatted file" radio button and then select "other".  You should then type "image", ".gif", ".
jpeg", or ".jpg" in the text box below the "other" button. This tells Morpho to display the data 
as an image when the package is viewed later. Then continue through the Wizard as with 
any other data file. You will need to fill out at least the minimal information indicated on 
several of the next screens.

4. Can I customize Morpho in any way?

In versions 1.3 and earlier,. there is no command within the Morpho program to set any 
preferences. (In Morph 1.4.0, there is a "Set preferences..." menu item in the "File" menu. 
That menu item makes it unnecessary to change the configuration file as described here.) 
There are some preferences (and additional data) that are read from the 'config.xml' file that 
is stored in the ".morpho" directory in the user's home directory. Only a few of these should 
be set by the user. These include:

<lookAndFeel></lookAndFeel>  ---  As shown on the left, there is nothing between the pair 
of "lookAndFeel" tags in the default config.xml file. This causes the look of the Morpho 
display to mimic that of the current operating system - e.g. Windows, Mac, etc. You can see 
a different look by changing the tag set to be "<lookAndFeel>kunststoff</lookAndFeel>". 
This will cause a variety of minor changes in the look of buttons, scroll bars, etc. The 
"kunststoff" is a customized look-and-feel created for Java applications.

<log_file>false</log_file> --- Changing the value within these tags from "false" to "true" will 
send all error messages to a log file. This may be useful if you are having problems.

<metacat_url>http://metacat.nceas.ucsb.edu/knb/servlet/metacat</metacat_url> --- The url 
of the network server where data is stored is set here. You may need to change this if you 
are using a custom server.

5. How can I "Export" a datapackage? The Export menu item doesn't seem to work.

There may be some confusion because the Export command asks you to select a 
"directory", not a file. Select a directory where you want the package exported to. On the 
Mac, you may need to actually type in the name of directory after selecting its parent 
directory.

6. How can I get more information on problems?

Morpho sends a number of messages about operations that are normally not visible when 
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you start Morpho using the icons created by the installer. On a Windows machine, the 
program that normally launches Morpho is called "Morpho.exe". An alternate method for 
launching Morpho (Windows only) is to execute the batch file "morpho.bat" which is located 
in the directory where Morpho was installed. When launched using the batch file, a 
background command window will appear and a number messages will appear in this 
window while Morpho is running. You can also see all these messages in a log file that is 
created when the "<log_file>" parameter is set to "true" in the configuration file (see FAQ 
question #4).

7. What are the system requirements for running Morpho?

For reasonable performance, a fairly new computer system is recommended (i.e. a clock 
speed or 700MHz or greater and 256 MB of RAM or greater). Morpho will run on slower 
systems with less RAM, but some operations may be very slow.  More RAM is especially 
useful of there are a large number of local data packages, since the local data is cached in 
RAM at startup. Some operations will require several minutes to complete even on newer 
computers. One example is the initial display of very large (10s of MB) data files.

8. How can I add data to a data file?

One can simply paste data from the clipboard into a data file displayed in Morpho. However, 
currently Morpho does not automatically add rows to the data file when information is 
pasted. Thus, if you want to add data, you will need to create additional rows before pasting 
the new data. Select the last row and then use the "Data" menu, the popup menu you get 
when you right-click on the data table, or press <Ctrl><i> to insert a new empty row. When 
enough rows have been created, you can select the top empty row and paste new data. 
Note that the default when copying/pasting from Excel is tab-delimited data. All the data will 
end up in the first cell if the data being pasted uses a different delimiter that the existing data 
(e.g. pasting from Excel when the existing data is comma-delimited.).
 

 

Help Index Placing a Data Package on a Network        
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